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About this manual

Welcome to the Sony Personal Entertainment Organizer (referred to as
the “Sony CLIE Handheld” or “CLIE handheld” in this manual).
Your Sony CLIE Handheld comes with three manuals:

Read This First

The Read This First manual gives an overview of your CLIE
handheld’s features, hardware and software setup, installation
instructions, and other important details. Before reading the rest of the
manuals, read the Read This First manual.

Operating Instructions
The Operating Instructions manual describes all you need to know
about how to use your CLIE handheld and the Personal Information
Management (PIM) applications that come with it.

This manual shows you how to:

® Turn on and off your CLIE handheld, reset the CLIE handheld, and
enter data in greater detail (Chapter 1)

m Use the Personal Information Management applications: Date Book,
Address Book, To Do List, Memo Pad, and Calculator (Chapter 2)

m Perform a HotSync operation with your computer (Chapter 3)

m Exchange data with another handheld by beaming or via “Memory
Stick” media (Chapter 4)

m Personalize your CLIE handheld with your own preferences settings
(Chapter 5)

® Maintain your CLIE handheld and use the Troubleshooting guide
and other technical information (Chapter 6)

Add-on Applications Guide (this manual)
The Add-on Applications Guide describes how to install and use the
supplied add-on applications that include:

m PictureGear Pocket/PictureGear 4.3Lite
m gMovie
m MS Autorun



Chapter 1

Viewing image files
(PictureGear Pocket)

This chapter describes how to view image files on
your CLIE handheld.




What you can do with PictureGear Pocket

PictureGear Pocket is a picture album application for your CLIE
Handheld.

Anytime anywhere...

Using PictureGear Pocket, you can store still image files from various
sources including those taken with a digital camera or those
downloaded from the Internet to your CLIE handheld. You can look at
your favorite image files anytime and anywhere.

Using PictureGear Pocket to present your creations

You can display image files in a sequence using the Slide Show
function. PictureGear Pocket helps you make presentations using
illustrations drawn on a computer or image files taken with a digital
camera.

Beaming my image files ...
Use IR (Infrared) communication to exchange image files easily with

other CLIE handheld users. You cannot beam image files to other Palm
OS based devices.

Pasting a image file to an address record
You can paste an image to address information.
For details, refer to the Operating Instructions manual.



Installing

You do not have to install PictureGear Pocket on your CLIE
handheld

The PictureGear Pocket application is factory pre-installed, you do not
have to install it.

Installing the PictureGear 4.3Lite software to your computer

You can convert the image file stored in your computer using
PictureGear 4.3Lite. To view image files or movies with your CLIE
handheld, use PictureGear Pocket or gMovie player respectively.

1 Insert the Installation CD-ROM into the CD-ROM drive.

The installation launcher window appears.

2 Click Install CLIE Image Software.

The dialog box used to select an installation option (Install
PictureGear 4.3Lite or QuickTime) appears.

3 Click Install PictureGear Lite.
A confirmation dialog box appears.

(319204 1e25H21nd14) sajiy abew Buimaip

4 Click Yes.
The PictureGear 4.3Lite software installation starts.
Follow the instructions on-screen to finish installation.

5 Click Exit.
To start PictureGear 4.3Lite

From the Start Menu, click Programs (All Programs in
Windows® XP), PictureGear 4.3Lite, and PictureGear
4 3Llite.

For details on how to use PictureGear 4.3Lite, see the Help files of the
PictureGear 4.3Lite software.
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Viewing image files stored in your CLIE
handheld

You can transfer image files taken by a digital still camera or
downloaded from the Internet, etc. These items can be managed using
PictureGear 4.3Lite software on your computer. You can also optimize
photos to display on your CLIE handheld using PictureGear 4.3Lite
software before transferring them to your CLIE handheld.

(o)

For details on how to save image files in the format supported by
PictureGear 4.3Lite software, refer to the instruction manual of the
devices or imaging software you are using.

Transferring image files to your CLIE handheld

Prepare image files you want to display on your CLIE handheld, then
transfer them to your CLIE handheld.

1

2

Start PictureGear 4.3Lite.
See page 7 for details.

Select the image file you want to send.

You can also select multiple slides by holding down the Ctrl or Shift
keys while clicking.

From the File menu, select Output services and then
Install the image during the next HotSync.
The User name dialog box appears.

Click the arrow V¥ to the right of the text box, and then
select a user name.

If necessary, click “Still settings” and make size and compression
settings for the image file you want to send in the Settings for
PictureGear dialog box.

Click OK.

The image file you want to send and the user are registered in
PictureGear.

Place your CLIE handheld in the cradle, then press the
HotSync button on the cradle.

The registered image file(s) are automatically sent to the user’s CLIE
handheld during the HotSync operation.




When you want to save an image file to “Memory Stick”
media
You can also transfer image files to “Memory Stick” media directly.
Select Output CLIE Handheld format file to Memory Stick in step 3 on
page 8.
To view image files stored in “Memory Stick” media, see page 13.

(319204 1e25H21nd14) sajiy abew Buimaip



Viewing image files stored in your CLIE handheld

Viewing image files with your CLIE handheld

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select the PG Pocket and then press the Jog
Dial navigator.

Or, tap the PG Pocket icon on the Application Launcher screen.

En — - Al
o O

araffiti HotSyne

=
D

flerno Pad WS Gate  MSAu

L8,
ToDolLizt  Welcome

PictureGear Pocket starts.

PG [T T w Internal  w Unfiled

Cicean

Hibizcuz  Harnster Riner

2 Tap the arrow ¥ on the top center of the screen to select
Internal.

PG Pock rrial w Lnfilad

Cicean

Hibizcuz  Harnster Riner
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3 Rotate the Jog Dial navigator to display the desired
image file, then press the Jog Dial navigator.
Or, tap the desired image directly.
The selected image appears.

4 When you want to show a memo or detailed
information attached to the image file, tap Menu
then tap[®] (memo) or [ (detailed).

(39204 Je2DRINII) 3|1y dbew] Buimain IERFEST. [T

Show memo Show detailed information

In the memo screen, you can view another image file by rotating the
Jog Dial navigator.

5 To return to the photo list screen, tap the screen or press
the Jog Dial navigator.
To return from the detailed information screen to the image file list
screen, tap Done on the bottom left of the screen or press the Jog
Dial navigator.
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Viewing image files stored in your CLIE handheld

Changing the image file list screen

You can change the image file list screen to display items by name and
date, or by thumbnail image.

PG 033 w Intatnal  w Unfiled PG [ T3S Internal  w Unfiled
Title Date 4 i I
E/231401 14:17:50
palrntres LRI RERERT
Qcean EA21000 140632
Hibiscus 278701 15:27:13
Harnstar EA231001 141820
River CA31/01 14:18:23
Hibiscus  Harnster ] Riwer
B =R T[]
By name and date By thumbnail image
(List mode) (Preview mode)

To display the image file list by name and date (List mode)

Tap .

To display the image file list by thumbnail image (Preview
mode)

Tap .
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Viewing image files stored in “Memory
Stick” media

Image files shot by a digital still camera or digital video camera
recorder and recorded in a “Memory Stick” media are stored in the
DCF (Design rule for Camera File system) format. This format differs
from the PGP format which is standard for PictureGear Pocket
software.

You can view both PGP format image files and DCF format image files
using PictureGear Pocket. In addition, you can convert DCF format
image files into PGP format image files, and save them to your CLIE
handheld or “Memory Stick” media.

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select PG Pocket and then press the Jog Dial
navigator.

Or, tap the PG Pocket icon on the Application Launcher screen.
PictureGear Pocket starts.

2 Insert the “Memory Stick” media into the “Memory
Stick” slot.

3 Tap the arrow ¥ on the top center of the screen to select
MS.

PG Pocke - + Lnfiled
Iy —

W,

(319204 1e25H21nd14) sajiy abew Buimaip
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II Continued on next page
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Viewing image files stored in “Memory Stick” media

4 f you want to view DCF image files taken by the digital
still camera etc., tap DSC.

If you want to view image files converted by the PictureGear Pocket
or PictureGear 4.3Lite software, tap PGP.

F’G Pocket [l

DSCO004%.| DSCO01 23, DSCO0189.

DSCO0191. DSCO0193, DSCO0202

You cannot move, copy, delete or transfer DCF format image files using the MS
Gate application. However, you can convert them into PGP format image files
using PictureGear Pocket, and save them to your CLIE handheld.

Notes on DCF format

* DCF (Design rule for Camera File system) is an industry standard format for
storing image files established by JEIDA (Japan Electronic Industry
Development Association).

¢ Using the PictureGear Pocket application, you cannot view image files shot
by a device that does not support the DCF format such as the Sony digital
video camera recorder DCR-TRV9000 or Sony digital still camera DSC-D700/
D770.

* DCF format image files are stored in the DCIM directory of the “Memory
stick” media.

* PictureGear Pocket displays thumbnail images (160 by 120 pixels) of DCF
format image file. Therefore, the display quality is inferior to the real picture.

* In order to display clearer pictures with PictureGear Pocket, it is
recommended that you use PictureGear Lite on your computer when
converting the image files to PGP format before storing them in a “Memory
stick” media.
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Saving DSC image files stored in a “Memory Stick”
media to your CLIE handheld

1 Display the DSC photo you want to save.

2 Tap Menu Ef] then the P (Save) icon shown at the
bottom of the screen.
The confirmation dialog appears.

3 Tap OK.
The selected image file is converted in the PGP format and saved to
the CLIE handheld.

To stop saving
Tap Cancel in step 3 above.
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Viewing image files stored in “Memory Stick” media

Saving multiple DSC image files to your CLIE handheld at
once

1 In the photo list screen, tap [ (Store).
The check boxes for each image file appear.

F’G Pocket IS

D5C00048.) DSCO0123. DSCO0188.

Di i I;! Ll

DSCO0191. DSCO0183. DSCO0202.
[ Selectall ) [ Store ) (Cancel )

2 Tap the check box to select the image file you want to
save.

3 Tap STORE.

The confirmation dialog box appears.

4 Tap OK.
The selected image file is converted to the PGP format and then
saved to your CLIE handheld.
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Viewing image files one after another
(Slide-Show)

You can view all image files in a particular category one after another
(slide-show).

1 Sselect the category you want to view in the slide-show.

2 On the image file list screen, tap [id.
The slide-show screen appears.

Order:

Glass
palrntres
Ocean
Hibizcus
Harnster
Riwver

Interval: w 1 Sec. O Loop

Fad
o o

3 Make the desired setup.

¢ Interval: set interval to determine the length of time an individual
image file will be displayed.

¢ Loop: if you want to repeat the slide-show automatically from the
start, tap to select this check box.

(319204 1e25H21nd14) sajiy abew Buimaip

¢ Fade: if you want to set the fade effect in the image file transition,
tap to select this check box.

4 Tap Start.
Image files in the selected category appear one after another.

5 To exit the slide-show, press the Jog Dial navigator or
tap the screen.
The slide-show ends.

Changing the displayed order
On the slide-show screen, drag the image file name to the desired
position.

17



Viewing sample image files

You can view sample image files installed on your computer.

Install the CLIE Palm Desktop software to your hard disk using the
supplied CD-ROM and then place your CLIE handheld in the cradle.

1 Double-click the Palm Desktop for CLIE icon on the
Windows desktop.
The Palm Desktop for CLIE software starts.

2 Click Install.
The Install Tool dialog box appears.

W

Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select the folder manually.

At the default setup, Add-on folder is stored in the Sony Handheld
folder of the Program Files folder.

5 Double-click the PG Pocket samples folder.

6 Double-click the sample image file you want to view on
the screen of your CLIE handheld.
The selected image file name is added to the File Name list.
If you want to other sample images, repeat this step.

N

Click Done.

8 Press the HotSync button on the cradle.

The selected sample image files will be installed on your CLIE
handheld.

O Start PictureGear Pocket.
For details, see page 10.
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How to read the online manual

The detailed information of the PictureGear Pocket software is
provided with the online manual in the supplied CD-ROM.

To see the online manual, the Adobe Acrobat Reader software must be
installed on your computer.

1

2
3

Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.
Click Manuals.

Double-click PictureGear Pocket Manual.pdf.
The online manual appears.

If the Acrobat Reader software is not installed

1

Nowun h~ WN

Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.
Click Exit.

Double-click the My Computer icon on the Windows
desktop.

Right-click the CD-ROM drive icon, and then click Open
from the shortcut menu.

Double-click the PC folder.
Double-click the Acrobat folder.

Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.

19
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Chapter 2

Playing a movie (gMovie player)

This chapter describes how to play a movie on your
CLIE handheld.




What you can do with gMovie player

gMovie is an application which allows you to display or play back
video data created using Windows® applications such as PictureGear
4.3Lite, on your CLIE handheld.

Playing movies on your CLIE handheld

You can play a movie that has been converted to the proper format
and then transferred from your computer, or stored in the “Memory
Stick” media.

You can enjoy your favorite movies anytime, anywhere.

22



Installing

You do not have to install gMovie player on your CLIE handheld
The gMovie player application is factory pre-installed, you do not have
to install it.

Install PictureGear 4.3Lite software to your computer

Install PictureGear 4.3Lite software to your computer according to the
instructions on page 7.

(19he|d a1n0Nb) S1n0w e Bulheld B, Ja;deqa
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Playing movies with your CLIE handheld

You can transfer movies shot by a digital still camera or downloaded
from the Internet, etc., which are managed by the PictureGear 4.3Lite
software on your computer. You will need to optimize movies on your
CLIE handheld by the PictureGear 4.3Lite software before transferring.
For details of operations or how to save the movies in the format
which is supported by the PictureGear 4.3Lite, refer to the online Help
of the PictureGear 4.3Lite.

Transferring movies to your CLIE handheld

Prepare the items you want to display on your CLIE handheld, then
transfer them to your CLIE handheld.

1 Start PictureGear 4.3Lite.
See page 7 for details.

2 Select the movie you want to send.

You can also select multiple slides by holding down the Ctrl or Shift
keys while clicking.

3 From the File menu, select Output services and then
Install the image during the next HotSync.
The User name dialog box appears.

4 Click the arrow V¥ to the right of the text box, then select
a user name.

If necessary, click Movie settings and make size and compression
settings for the image you want to send in the “Settings for Movies
on CLIE Handheld” dialog box.

5 Click OK.

The slides you want to send and the user name are registered in
PictureGear.

6 Place your CLIE handheld in the cradle, and then press
the HotSync button on the cradle.

The registered slide(s) are automatically sent to the user’s CLIE
handheld during the HotSync operation.



When you want to save a movie to the “Memory Stick”
media
You can also transfer the movie to the “Memory Stick” media directly.
Select “Output CLIE format file to Memory Stick” in step 3 on page 24.

(49Ae|d aino\6) ainow e Buiheld
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Playing movies with your CLIE handheld

Playing movies

1 On the Application Launcher screen, rotate the Jog Dial
navigator to select gMovie and the press the Jog Dial
navigator.

m=‘ - Al
A, e

Address Cale iard In%o
5 =
cC 5 P

CLIE Dermo  [ate Book
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Graffiti Hot%wne
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Merno Pad M5 Gate  MESRutorun -

Or, tap the gMovie icon on the Application Launcher screen.
gMovie player starts and the movie list screen appears.

2 Tap the movie you want to play.
Playback starts.

46

To stop playback
Tap Il (Stop).
To resume playback, tap [ ] (Play).

To locate the start point of the movie
Tap 14 (Locate).
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To return to the movie list screen
Tap [E] (Return) at the upper-right corner of the screen.

To play the next movie
Tap F (Next) at the upper-right corner of the screen.

To play movies one after another (continuous playback)
Tap # (Next) at the upper-right corner of the screen for a few seconds.
The icon changes into B (Continuous) and movies stored in your CLIE
handheld are played one after another.
To return to the normal playback, tap [ (Continuous) for a few
seconds.

To delete a movie

1 Display the movie you want to delete, then tap Menu

RN
2 Tap Delete.
3 Tap OK.

The selected movie is deleted, and then the movie list screen
appears.

(19he|d a1n0Nb) S1n0w e Bulheld B, Ja;deq:)
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Playing sample movie files

You can view sample movie files installed on your computer.

Install the Palm Desktop for CLIEsoftware to your hard disk using the
supplied CD-ROM and then place your CLIE handheld in the cradle.

1 Double-click the Palm Desktop for CLIE icon on the
Windows desktop.
The Palm Desktop for CLIE software starts.

2 Click Install.
The Install Tool dialog box appears.

W

Select a user name from the user list.

4 Click Add.
Make sure that the Add-on folder is selected.
If the Add-on folder is not selected, select the folder manually.

At the default setup, Add-on folder is stored in the Sony Handheld
folder of the Program Files folder.

5 Double-click the gMovie samples folder.

6 Double-click the sample movie file you want to play on
the screen of your CLIE handheld.
The selected movie file name is added to the File Name list.
If you want to view other sample movies, repeat this step.

N

Click Done.

8 Press the HotSync button on the cradle.

The selected sample movie files will be installed on your CLIE
handheld.

9 Sstart gMovie player.
For details, see page 26.

28



How to read the online manual

Detailed information on gMovie player software is provided in the
online manual on the supplied CD-ROM.

To see the online manual, the Adobe Acrobat Reader software must be
installed on your computer.

1 Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.

2 Click Manuals.
3 Double-click gMovie Manual.pdf.

The online manual appears.
If the Acrobat Reader software is not installed

1 Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.
Click Exit.

Double-click the My Computer icon on the Windows
desktop.

(19he|d a1n0Nb) S1n0w e Bulheld B, Ja;deq:)

Right-click the CD-ROM drive icon, and then click Open
from the shortcut menu.

Double-click the PC folder.

Double-click the Acrobat folder.

Nowun h~ WN

Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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gMovie menu items

The following items appear when you tap the MENU icon while the
movie file is displayed on your CLIE handheld screen.
This section describes the menu commands specific to gMovie.

Media menu
When you tap Menu in the media list screen, following items
appear.

About gMovie
Shows version information of the gMovie application.

When you tap Menu in the movie file screen, following items
appear.

Details
Shows detailed information on the current media.

Beam Media

Transfer the data contained in the current media to another CLIE
handheld via the IR port. For details about beaming, see the Operating
Instructions manual supplied with the CLIE handheld.

Delete
Deletes the current media. Tap OK in the Delete Media dialog box to
perform deletion. Tap Cancel to cancel deletion.

Preferences
Displays options for movie playback option available:

0 Loop movie playback:

if you want to play the current movie file repeatedly, tap to select
this check box.

When you tap to clear the check box, you cannot play the next
movie file by tapping # (Next) at the upper-right corner of the
screen. In this case, tap ™ (Play) manually to play the movie file.

About gMovie
Shows version information of the gMovie application.
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Chapter 3

Setting the “Memory Stick” automatic
start function (MS Autorun)

This chapter describes how to set the “Memory
Stick” automatic start function on your CLIE
handheld.

When you want to start an application in the
“Memory Stick” media from the Application
Launcher screen, refer to the Operating
Instructions manual.




What you can do with MS Autorun
application

“Memory Stick” Autorun (hereafter referred to as MS Autorun) is an
application which allows your CLIE handheld to copy and start a
specified application automatically when “Memory Stick” media is
inserted into the CLIE handheld. Removing the “Memory Stick”
media automatically deletes the application copy from the memory of
the CLIE handheld. MS Autorun functions as virtual memory to
effectively utilize the memory of the CLIE handheld.

Starting an application (.prc) on the CLIE handheld automatically
When you use a digital still camera that is compatible with “Memory
Stick” media, you can view your images by inserting the “Memory
Stick” media into the CLIE handheld. In this example, you would use
the auto-run setting to start the PictureGear Pocket application on your
CLIE handheld.

Starting an application (.prc) in a “Memory Stick” media
automatically

This setting is for automatically starting an application which does not
access any data, such as game applications, or an application which
accesses data in the CLIE handheld (not in the “Memory Stick” media).

Starting a pre-selected application (.prc) and related database
files (.pdb, .prc) in a “Memory Stick” media*

This setting automatically displays a specific image or file with an
application such as an image viewer or a document reader. You need
to specify an application and the related database files before using
this auto-run setting.

Starting an application (.prc) on the CLIE handheld automatically
with specific database files (.pdb, .prc) from a “Memory Stick”
media*

This setting is used when the application is located on the CLIE
handheld and the corresponding database files are located on a
“Memory Stick” media. You can also display the desired data
automatically by inserting the “Memory Stick” media into your CLIE
handheld.

* If you specify PictureGear Pocket as an auto-run application, tap the arrow ¥
on the top center of the screen in PictureGear Pocket to select “MS.” Likewise,
if you specify gMovie player as an auto-run application, tap the movie file
you want to play.
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® It is not recommended that you use the MS Autorun application with the
Address Book, Date Book, To Do List, Memo Pad, Calculator or Mail
application. Problems may occur if the data of these applications do not
reside on your CLIE handheld when you perform HotSync operation.

 The specified application may not start automatically depending on the
application in use when you insert the “Memory Stick” media into your CLIE
handheld. In this case, return to the Application Launcher screen, and then
insert the Memory Stick media again.

You do not have to install MS Autorun on your CLIE
handheld

The MS Autorun application is factory pre-installed, you do not have
to install it.
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Setting Auto-run for an Application

To automatically start an application stored in a Memory Stick media,
perform the following procedure.

This procedure is an example to set the PictureGear Pocket application to start
automatically. In this case, a Memory Stick media containing photos must be
inserted to the CLIE handheld.

1 Install an application you want to start automatically
(PictureGear Pocket) on the CLIE handheld.

The PictureGear Pocket application is preinstalled in some series of
the CLIE handheld, including this model.

2 Insert the “Memory Stick” media for which you want to
set the autorun function into the “Memory Stick” slot.

3 On the Application Launcher screen, rotate the Jog Dial
navigator to select MSAutorun and then press the Jog
Dial navigator.

MS Autorun starts.
Or, tap MSAutorun icon on the Application Launcher screen.

4 Press the Jog Dial navigator.
The application list in your CLIE handheld appears.

5 Tap the application (PictureGear Pocket) for which you
want to set the auto-run function.

6 Tap Set.

The setting is stored in the “Memory Stick” media, and the
confirmation dialog box appears.

7 Tap OK.

The auto-run setting is completed.

8 Tap Home [ to return to the Application Launcher
screen.

9 Remove the “Memory Stick” media.
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To use the auto-run function with this example
When the Application Launcher screen is displayed and you insert
“Memory Stick” media into your CLIE handheld, the PictureGear
Pocket application starts automatically.
In this case, if you remove the “Memory Stick” media, the PictureGear
Pocket quits automatically and the Application Launcher screen
appears.
For further operation, refer to the online manual for the MS Autorun.

If “Internal” is displayed at the top center of the PictureGear Pocket screen
during operation described above, the image files stored in your CLIE handheld
are displayed.

To view image files stored in the “Memory Stick” media, tap the arrow ¥ on the
top center of the screen to select “MS.”
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How to read the online manual

Detailed information on MS Autorun software is provided in the
online manual on the supplied CD-ROM.

To see the on line manual, the Adobe Acrobat Reader software must be
installed on your computer.

1 Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.
2 Click Manuals.
3 Double-click MSAutorun Manual.pdf.

The online manual appears.
If the Acrobat Reader software is not installed

1 Insert the supplied CD-ROM into your computer’s CD-
ROM drive.

The install screen appears automatically.
Click Exit.

Double-click the My Computer icon on the Windows
desktop.

Right-click the CD-ROM drive icon, and then click Open
from the shortcut menu.

Double-click the PC folder.

Double-click the Acrobat folder.

Noun A~ WN

Double-click ar500enu.exe to install the Acrobat Reader
onto your computer.
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MS Autorun menu items

The following items appear when you tap the MENU icon.
This section describes the menu commands specific to the MS Autorun
application.

Options menu

Display log

When Memory Stick media is inserted into or removed from your
CLIE handheld, a history log is created. From the Options menu, you
can view this information by tapping Display log.

Tools
The following buttons appear in the Tools dialog box:

* Recover:
This button is displayed if the auto-run function is performed and
the MS Autorun application is started without removing the
Memory Stick media. You can delete the application and database
files copied into your CLIE handheld.

¢ Delete autorun setting:
This button is displayed if the auto-run setting file is stored in the
inserted Memory Stick media. You can delete the auto-run setting in
the Memory Stick media.

Preferences
Displays the Preferences dialog box.
The following items appear on this dialog box:

*Autorun:[ Disable:
You can temporarily cancel the auto-run function.

¢ S List:
You can switch the format of the list of data in Memory Stick media.

About MS Autorun
The version information of the MS Autorun application is displayed.
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For the latest support information,
check our official Sony CLIE Web site

http://www.sony.com/clie

http://www.sony.net/
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